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Copyrights and Trademark Notices
Copyright 2017, Telestream, LLC. All rights reserved worldwide. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without the written permission of Telestream. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream.

Telestream. Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, 
Lightspeed, ScreenFlow, Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, 
MetaFlip, and Split-and-Stitch are registered trademarks and MacCaption, e-
Captioning, Pipeline, Post Producer, Tempo, TrafficManager, VidChecker, and VOD 
Producer are trademarks of Telestream, LLC. All other trademarks are the property of 
their respective owners.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 of Adobe Systems All 
rights reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights Reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 
|Server 2012, Windows 7, Windows 8, Media Player, Media Encoder, .Net, Internet 
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Explorer, SQL Server 2005|2008|2012|2014, and Windows Media Technologies are 
trademarks of Microsoft Corporation.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge 
Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-Loup Gailly and Mark Adler.
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Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
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STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.
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Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream via telephone at (530) 470-1300.

Part number: 267326
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Introduction to Vantage 
Workflow Designer Tours
These tours are designed to help you learn how to create and configure workflows in 
Workflow Designer, and submit media for processing. As you gain hands-on experience 
with Workflow Designer in Vantage, you’ll become familiar with important Vantage 
concepts, develop a working knowledge of Vantage and its components, and gain 
proficiency in using it to meet your media processing requirements.

Note: Sample workflows with short media samples are provided on the Telestream 
web site: http://www.telestream.net/telestream-support/vantage/workflow-
examples.htm. Unzip the zip file and save the media in a convenient location. The XML 
files are sample workflows that you can import using the Workflow Designer > File > 
Import Workflows menu selection. Some of the tours in this chapter use the samples, 
and some of the tours require you to build the workflows yourself.

Tours
 Tour 1: Creating a Simple Workflow
 Tour 2: Processing Media in a Workflow
 Tour 3: Using the Design Workspace
 Tour 4: Transcoding Files
 Tour 5: Using Nicknames to Identify Files
 Tour 6: Processing Attachments in Workflows
 Tour 7a: Using Catalogs and Binders in Ingest Workflows
 Tour 7b: The Workflow Portal and Trim Workflow
 Tour 8: Controlling Workflow Execution with Variables
 Tour 9: Decision Making in Workflows
 Tour 10: Analyzing and Modifying Media Files
 Tour 11: Understanding and Using Open Workflows

Note: You can take tours 1-4 without a Vantage license. For tour 5 and others, you’ll 
need a trial license to run workflows. Also, without a license, you can only decode 
WMV files in workflows. For a trial license, contact sales@telestream.net.

http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/telestream-support/vantage/workflow-examples.htm
http://www.telestream.net/vantage/help
mailto:sales@telestream.net
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Tour 1: Creating a Simple 
Workflow
Introduction
This tour provides a hands-on introduction to the concept and process of creating a 
typical Vantage transcoding workflow. In the following tour, you’ll submit some media 
to transcode, monitor your job as it executes, and then play the new media that 
Vantage produced using the workflow.

Vantage Workflow Designer is an intuitive, flexible, visual workflow design tool for 
creating and configuring workflows—the workhorses of Vantage. With visual workflow 
design and job status views, Workflow Designer provides a powerful, simple way to 
build an automatic video transcoding process from ingest to transcoding to output and 
distribution.

A workflow in Vantage is a series of connected actions arranged in a specific order to 
automate a media processing task: transcoding a file from one format to another, for 
example, moving the file to a desired location, and sending a completion message to 
the user. In addition, metadata processing, analysis and data extraction, and other 
workflow functions can all be performed in the same workflow.

Vantage provides many types of actions (the smallest amount of work you can specify 
in Vantage) which you can use to implement a specific media processing solution. For 
example, a Watch action continually polls a hot folder (such as a media server directory 
or a local or network folder) for incoming media to process—which Vantage performs 
by automatically submitting a job to the workflow you've created. Likewise, a Flip 
action transcodes media, and a Copy action replicates a file to another location.

The task specified by each type of action (Watch, Flip, Copy, etc.) is actually executed by 
a Vantage service (a special type of Windows program)—for example, the Watch action 
is executed by the Vantage Monitor service.

In this tour, you’ll log on to your Vantage domain using Workflow Designer, and create 
and configure a workflow to encode a QuickTime file.
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Starting Workflow Designer and Logging In
You can run Workflow Designer directly on your Vantage server, or you can install and 
run it on another Windows workstation on the LAN.

1. Double-click the Vantage Workflow Designer shortcut on your desktop or select 
Start and search Programs for Vantage Workflow Designer.

2. First Time Use—Click Search in the Select a Vantage domain window that opens to 
get a list of domains. 

After connecting the first time, Workflow Designer remembers the last domain you 
used, and connects automatically.

3. Select the domain you want to use, and click OK.

(A Vantage domain is identified by the computer that hosts the Vantage domain 
database—you are actually connecting the Workflow Designer client to the 
domain database. For example, if your Vantage domain database is on a server 
named Vantage_01, select that name from the domain list to make the connec-
tion.) 

If you have problems connecting to the domain, contact your IT department or 
Vantage administrator for assistance.

4. If the Vantage Domain Login dialog is displayed, enter your Vantage user name and 
password in the login dialog to proceed.

This is the list of domains 
running on your network. 
Select a domain and click 
OK.

Click Search to populate 
the list of domains.
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Note: If you need a user account, obtain it from the administrator or create one 
yourself in the Management Console. For assistance, run the console and select Help 
> Online Help. The default Vantage user name is Administrator, with no password.

Once you’re logged in, Workflow Designer displays the main window.

Creating a Workflow Category
When Vantage is installed, there are no categories or workflows stored in the Vantage 
domain database. So, the first user that logs in to a new domain is prompted to create a 
new category and workflow.

Note: Even if categories are present, you should make a category for use during these 
tours, so that your practice workflows don’t interfere with the work of others, and that 
they remain separate from production workflows.

If you’re prompted to create a new category, click OK. Otherwise, select File > Create 
New Category to display the Create New Category dialog.

Enter <Your Name> Tutorial Workflows and click OK. 

Note: For these tours, the category is referenced simply as Tutorial Workflows. 
Workflow Designer displays help tips as you use it, to help you become familiar with its 
features. If you don’t want Workflow Designer to display them, check Don’t show me 
this again.
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Creating a Workflow
Now, let’s create your first workflow to convert files to a small-frame (proxy) QuickTime 
file for preview purposes. 

1. If you’re prompted to create a new workflow, click OK. Otherwise, select File > 
Create New Workflow. Workflow Designer displays the Create New Workflow 
dialog.

2. Select the category you just created, from the list at the top of the dialog.

3. Enter the name Simple Transcode (in your Tutorial Workflows category), and click 
OK. (There’s no need to change the expiration policy settings now.)

Your new workflow is automatically added to the list in the Workflows panel under 
the category you created earlier.

When you create a workflow, it is automatically placed in edit mode, so you can begin 
adding actions.

You do not need to explicitly save workflows you create or modify. The changes you 
make as you create (or update) a workflow are saved automatically in the database.
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A Quick Look at the Workflow Designer Main Window
Now that you have a category and workflow created, take a minute to familiarize 
yourself with Workflow Designer.

Workflow Designer has a comprehensive set of menus, and several tabbed workspaces 
or panels.

On the left is the Workflows panel, with all of the domain’s workflows organized by 
category. To the right are several workspaces, identified by tabs—Workflow Design, 
Monitor Status, Job Status, and Domain Monitor Status, Domain Job Status, and 
Workflow Analytics. Each of these tabs displays a workspace for specific tasks you’re 
performing. In this tour, you’ll be working in the Workflow Design workspace, where 
you can create and configure your workflows.

Zoom control

Workflows panel—displays your 
workflows by category.

Use the Workflow Design workspace to 
construct and configure workflows.

Actions toolbar—
drag actions onto 
design area to add to 
workflow.

Zoom control

Workflow design in 
progress.

Nicknames | 
Variables View

Workflow Designer 
has workspaces for 
each key activity.
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Adding Actions to Your Workflow
You add actions and connect them together to form a workflow. Every workflow starts 
from an origin action (such as a Watch action monitoring a hot folder for new media to 
process) and continues execution of all other connected actions, each of which execute 
in left-to-right order when a job is submitted by the origin action.

All of the actions in Workflow Designer are arranged in functional groups in the Actions 
toolbar at the top of the Workflow Design workspace. The actions displayed in your 
Workflow Designer may vary from what is shown here if some actions are unlicensed.

Note: To re-arrange the groups in the actions toolbar, right-click in the toolbar and 
select Sort by Name or Sort by Behavior.

1. Open the Monitor group in the actions toolbar (click the arrow in the upper left 
corner of the group)—to display the Watch action and Associate action.

2. Click and drag a Watch action down onto the Workflow Design workspace to add 
your first action to the workflow. (Notice that it automatically centers itself—
Workflow Designer visually optimizes workflow actions automatically.) A Watch 
action polls a hot folder (which you need to specify) for new media files placed in 
the folder, and starts a job to execute the workflow using that file.

Note: You can also copy and paste actions in a workflow to duplicate them. Right-
click an action in the workflow and select Copy, then right-click in an empty area in the 
workspace and select Paste.

Actions are 
grouped by 
category. 
Click the arrow to 
open or close the 
group.
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3. Open the Transcode group and—rather than dragging an un-configured Flip 
action onto the workflow—click the Flip action one time to display a 
comprehensive list of pre-set Flip actions. (You can either use an un-configured 
action, or select a pre-configured action, which may make configuration easier.)

Select Web > QuickTime > QuickTime H.264 with AAC. The (pre-configured) action is 
added to the workflow and is arranged just to the right of the Watch action.

1. Open the Transport group, and drag a Copy action to design space.

Connecting Your Actions Together
To create a chain of actions which execute in sequence, you connect them together. 
Here are ways you can connect actions together:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action (either from the actions toolbar or one already in the work 
area) and bump it into the edge of the action you want to connect it to—until a 
pale blue vertical line displays. (You must drag your mouse pointer up to the edge 
of the action you’re connecting to).

• Copy an action, and right-click on a connector line and select Paste to add the cop-
ied action between the two actions. Or, drag an action onto a connector line until it 
displays as a larger line. Then, drop it to connect it between the two actions.

There are also two ways to disconnect actions:

• Hover over the center of the connecting line until a red X displays; click the red X to 
delete the line, or right-click and select Delete. 
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Try connecting your actions now:

1. Click and drag a connector line from the yellow connector pin on the right side of 
the Watch action to the yellow connector pin on the left side of the Flip action. 
(Connector pins display in yellow until they’re connected.)

2. Next, open the Transport action group and drag the Copy action out onto the 
canvas.

3. Now, click and drag the Copy action so that your mouse is directly over the right 
side of the Flip action (a connector bar displays in pale blue, as shown below). 

4. When the pale blue bar displays, release the mouse—the Copy action 
automatically connects to the Flip action.

Delete the Copy action by selecting it and pressing Delete—or click the X button in the 
upper right corner—and confirm the Delete dialog. 

1. Add the copy action back to the workflow and reconnect it after seeing how the 
delete function works. 

Note: Workflow Designer automatically saves your workflow in the database as you 
modify it. You do not have to save workflows manually.
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Configuring the Watch Action
Each action in a workflow performs a specific task or function (copy a file, for 
example)—and must be configured to perform the function specifically the way you 
want for a given workflow. 

You configure actions using the Inspector. The Inspector is one or more panels with 
configuration options—and the Inspector for each action varies, according to 
requirement of the action. For example, you configure a Watch action very differently 
than a Flip action.

Each action displays an i (for Inspector) button  in the top left corner; the color 
yellow indicates that it has not yet been configured (or configured correctly)—it 
displays blue when properly configured).

Vantage can process a broad array of media types and formats, and access all major file 
systems. In addition to standard file systems including Windows and FTP, Vantage 
intelligently works with several complex media types such as Avid reference movies, 
and P2 camera media files.

You’ll configure this Watch action to poll for any type of media file placed in a specified 
folder on a Windows server.
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1. Click on the  button of the Watch action (or, just double-click the action) to 
open the Inspector, and display the first panel.

This first panel allows you to choose a special media type to watch for (such as an 
Avid reference movie). Or, you can select Any Media which will work for most media 
types.

2. Select Any Media to poll for any type of new media and click Next. (Media files is 
checked by default.) Workflow Designer displays the next panel in the Inspector.

Note: Entries in these lists that are disabled have not been licensed, and thus, are not 
available to use.

This second panel allows you to choose which type of file system (such as FTP or 
Windows) that the action will be watching (monitoring).

File formats supported by 
Vantage—those in gray 
have not been licensed.



Tour 1: Creating a Simple Workflow
Starting Workflow Designer and Logging In

23
3. Select Windows as the type of file system to monitor, and click Next to display the 
next panel in the Inspector.

Note: If you’re using a Vantage array, where Vantage services and clients are 
distributed among several servers and workstations—or you access or deliver media 
on network servers—you must use UNC paths to identify media locations. The path 
must be a share with proper permissions (for example, \\MyDomainServer\HotFolder). 
Otherwise, your workflows will not function because it can’t find the path. Be sure to 
read Paths for Vantage Storage Overview for guidance. 

4. Open Windows Explorer and create a folder directly on the Vantage domain server 
for this workflow and name it VantageTourWatch. If you plan to reference it as a 
share, display Properties and enable sharing.

5. Return to Workflow Designer and click Browse to navigate and select the fully-
qualified path in this field. Or, enter the share path manually. 
This is now the hot folder for this workflow.

Click Browse to navigate to 
and select your hot folder or 
manually enter the path.
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6. Click Next. Workflow Designer displays the configuration panel.

7. Take a moment to review these settings. (You can place your mouse cursor over the 
controls to display tooltips which describe each setting.) You don’t need to make 
any changes to this panel.

8. Select a nickname for the incoming file—in this case, Original is already selected, so 
you don’t need to change it. (You’ll learn more about nicknames in Tour 5.)

9. Click the  button at the top right of the panel to open context-sensitive help (a 
man page) with detailed information about configuring this Inspector. Wherever 
you see the context-sensitive help button, you can click it to display details about 
the part of Workflow Designer you’re focused on. (Click the  icon to display the 
User Guide—the document you’re reading.)

10. Click Next and then click Finish to save this configuration of the Watch action.

Now that you’ve configured the action, notice that the Inspector button is hidden to let 
you know that it has been configured. Move your mouse back over the action—
Workflow Designer displays the Inspector button again—in blue. You can always re-
open the Inspector to review or change its settings.

You must select or enter a nickname in 
every action that acts on or creates a 
file, to uniquely identify and track this 
file instance throughout the workflow.
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Configuring the Flip Action
The Inspector button on the Flip action is yellow as well—meaning, it must be 
configured. Why does it need to be configured, given that you selected a pre-
configured action? Because the output file’s nickname hasn’t been specified.

1. Double-click the action to open the Flip Inspector, and note the red asterisk by the 
Output media file nickname field, indicating that a nickname is required.

2. Click the menu to view the list of nicknames for output files. Enter QuickTime H264 
AAC as the nickname for the file this action creates. Now, all subsequent actions in 
the workflow can reference the output from this Flip action, simply by referring to 
the nickname QuickTime H264 AAC.

Some of the nicknames in the list are key Vantage nicknames— they enable certain 
Vantage features or are required in certain actions. When you create your own nick-
names, they should be meaningful in the context of your workflow.

Note: The nickname you assign a file has no effect on the output file name (which by 
default, will be the same as the input filename, except for the extension). For example, 
if you submit test.mpg, this Flip action will create test.mov. The input file in this 
workflow is always referenced by the nickname Original and the output file is always 
referenced by the nickname QuickTime H264 AAC. 

You must select or 
enter a nickname 
in every action 
that acts on or 
creates a file, to 
uniquely identify 
and track this file 
through the 
workflow during 
execution of the 
job.
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3. Take a moment to click on each of the video stream, audio stream, and H.264 and 
AAC codec components, as well as the QuickTime Movie container component in 
turn, and review the details panel for each component (the details panel displays 
below the building blocks). Also note the toolbar directly above the building 
blocks. This is the comprehensive user interface for configuring Flip (transcoding) 
actions in Workflow Designer.

4. Click Save to save this configuration of the Flip action, and note that the yellow 
Inspector button no longer displays. 
Now, when you hover over the action, the Inspector button displays in gray, and 
when you hover over the Inspector button itself to select it, it displays in blue.

Configuring the Copy Action
Now let’s move on to the Copy action. This action will copy the transcoded file from the 
Vantage Store to whatever other location you prefer, such as another server and folder.

1. Click the Copy action Inspector to open it.

2. Select the nickname of the file to copy (QuickTime H264 AAC). 

3. Select another nickname for the copied file, such as Final Output.

4. Select the destination by selecting Path and Browsing to a location. 

5. Next, you have to turn the destination into a UNC path. To do so, add a double 
backslash and the server name at the front of the path. 
Example: \\server\C:\MediaStore\CopyDestination

6. Click Save to save the Copy action. 

Conclusion
Congratulations! You’ve just learned how to create a workflow, and learned the basics 
of configuring actions using Workflow Designer’s Inspector. You’ve created a complete 
workflow which can detect new media files placed in a hot folder, and convert them to 
QuickTime format.

In the next tour, you’ll learn how to activate workflows, submit jobs, and monitor them.
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Tour 2: Processing Media 
in a Workflow
This tour shows you how to process media in your workflow—which involves activating 
a workflow, submitting media to transcode, monitoring the job as it executes—and 
viewing the new media it generates.

You can start a job from an active workflow in various ways:

• Place a media file in a hot folder to submit a job automatically

• In the Watch action Inspector, check Process Existing Media. Then, select a hot 
folder which already has one or more media files, and activate the workflow—this 
causes Vantage to process all existing media in the directory, rather than ignore the 
existing files.

• Click the Submit Job button (at the bottom of the window) and select the file (or 
files) to submit manually. Just follow the steps in each panel.

• Drag and drop a file (or files) directly onto the origin (Watch or Receive—or Catch 
or Dublist in TrafficManager) action of a workflow. 

There are other, specialized ways to start jobs, but these are the main ones. In this tour, 
we’ll drop a media file in a hot folder to start a job automatically.

Activating a Workflow
To activate a workflow, follow these steps:

1. If you closed Workflow Designer, open it again.

2. Select your Simple Transcode workflow in the Workflows panel on the left.
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3. Click the Activate button at the bottom of the window. 

Workflow Designer releases it from edit mode and the Vantage Monitor Service starts 
the Watch action in your workflow, polling the hot folder you specified, searching for 
new media files to process. A job is started for each new file placed in this folder.

Click Activate to release the workflow from editing, save 
it, and activate it to start the Watch action.
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Monitoring your Workflow Status
When you activate a workflow, Workflow Designer automatically displays the Monitor 
Status workspace to show you the status of all Watch actions. (You can always select 
any workflow and view its monitor (or job) status, including a record of past jobs.)

• Notice that the action state of the Watch action is listed as In Process, which indi-
cates it has started executing, and it is polling for new files. 

• When a new file is discovered, a job is created that executes the Simple Transcode 
workflow. 

• Actions may also be Waiting—the state that the transaction enters while Vantage is 
determining which service should process it. A transaction remains in Waiting state 
until it is accepted by a service for processing.

• If you deactivate the workflow, the Watch service stops monitoring the hot folder, 
and the record is saved in the database for history. When you re-activate the work-
flow, a new record is added to the list. 

• You can double-click the Watch action entry in the table to display more detailed 
information. You can confirm that it is polling the directory that you specified, and 
that no new files are detected—or that you’ve made an error in the file path that 
needs to be fixed, for example.
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Note: You may have also noticed the Domain Monitor Status workspace—the only 
difference is one of scope—it displays all of the monitors in the entire domain.

When jobs are started, each action is executed by a corresponding Vantage service, and 
can be optimized for execution if multiple services (for example, multiple Transcode 
services) are in your domain.

Now, submit a job by following these steps:

1. Drag a file to your hot folder to submit a job. We suggest that you use one of the 
sample media files provided, which are located at <InstallDrive>:\VantageStore 
(typically, C:\VantageStore), in an All-in-one domain. (If sample media was not 
installed, just use your own.)

2. Click the Job Status tab to display the Job Status workspace to monitor the status of 
running jobs.

m
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3. Click on the new job entry in the table, and observe each action change color as the 
entire job executes each task specified by the actions in the workflow. 

Actions display specific border colors to identify each action’s state. For example, a 
yellow border indicates the action hasn't started executing yet. A green border 
indicates the action is currently executing, and a blue border indicates the action 
has completed without errors. For a complete list of colors and their meanings, see 
Using the Jobs Table.

4. Move your mouse over actions in the workflow in the Job Status workspace. 

5. Click the Inspector button or just double-click the action to display run-time 
information about the action in the Status/History window.

6. Click on each succeeding status line in the Status/History window to display details 
about the action. Close this window when you’re done.

When all actions are outlined in blue, the job has completed successfully.

Playing Your New File
Now that the job has completed, Vantage has encoded a new QuickTime file.

Note: You didn’t configure the Flip action to tell it where to save new files. So, where 
are the new files saved? The short answer: unless otherwise specified, new files are 
written to a Vantage store—a pre-defined directory for storing temporary files.

1. In the Job Status workspace, make sure your job entry is selected in the Jobs table 
at the bottom.
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2. Click on the Binders  button to display the binder for this job.

A binder in Vantage keeps track of the location of media files associated with a job, 
plus metadata labels and other attachments (files).

3.  Right-click the output file labeled QuickTime H264 AAC. This is the file your 
workflow transcoded into QuickTime. 

4. Click the green Play button in the preview window or double-click the file to open 
your default video player and play the file.

Deactivating a Workflow
In an upcoming tour, you’ll use a copy of this same workflow. You should deactivate this 
workflow so that you can use the same hot folder in the next workflow, without the 
Simple Transcode workflow ingesting new media you add to the hot folder. 



Tour 2: Processing Media in a Workflow 35
Select the Simple Transcode workflow in the Workflows panel, and click Deactivate at 
the bottom of the window.

If you want to edit the workflow again, select File > Edit Workflow or click Edit at the 
bottom of the window. When you’re done editing a workflow, you should click Release 
so that it can be edited or executed by others in the organization.

Conclusion
Congratulations! You’ve just learned how to automatically submit media to a workflow, 
monitor its execution, and view the transcoded media file.

In the next tour, you will explore how to use the Workflow Design workspace 
effectively.
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Tour 3: Using the Design 
Workspace
Introduction
Now that you know how to create workflows and submit media, let’s take a moment to 
learn some techniques for using the Workflow Design workspace effectively. 

Some workflows—like Simple Transcode—have only a few actions in them; others may 
have dozens of actions. Sometimes you’re working on the big picture of a workflow—
laying out actions and connecting them together. Other times, you’re working on 
action details—configuring the details of a transcode task, for example. 

In each case, you may want to zoom in or out, scroll around, or center the work area, to 
help you focus directly on the work you’re performing at the moment.

Types of Workflow Actions
There are many different types of actions you can use to build your workflows, each 
designed to help you create comprehensive, powerful media processing tools. Here’s 
an overview of major groups and actions.

Monitor—includes actions such as Watch, for ingesting media (or media descriptor) 
files and starting jobs for the workflow. These monitor directories on a wide variety of 
computers and media-centric file systems and platforms. The Workorder action enables 
batch submission multiple input files to a given workflow.

Traffic—for processing local and regional, and national commercials to on-air or 
broadcast, including interacting with catch servers. Actions include the Catch action 
and Dublist action. These actions are part of TrafficManager.

Live—the Capture action is the origin action; it sets up Vantage to ingest streaming 
media. This service works only on a Lightspeed Live Capture server.

Cloud—the Cloud action moves media to the Telestream Cloud platform for processing 
in Cloud-based workflows.

Metadata—includes actions (Populate action and Transform action) which allow you to 
automatically edit and update metadata labels, and transform labels and attachments.
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Catalog—includes actions (Register action and Exist action) which allow you to register 
media in Vantage’s catalog for safekeeping and further processing and analysis by 
other workflows.

Timed Text—Transcodes media while extracting captions or converting a caption or 
subtitle file.

Transcode—Flip actions includes a broad suite of encoders and codecs, and allow you 
to encode media on a file-by-file basis.

Analysis—includes a wide variety of actions which allow you to examine video and 
audio for specific characteristics and metrics, and extract the results for use in building 
intelligent, adaptable workflows.

Multiscreen—the Multiscreen Flip action allows you to encode adaptive- or multi-
bitrate packages such as Apple HLS and MPEG DASH.

IPTV VOD—The IPTV Flip action allows you to encode Transport Stream containing 
MPEG-1, MPEG-2, H.264 and HEVC (H.265). It uses Manzanita multiplexing technology 
to give you fine control over Transport Stream creation.

Edit—Includes the actions for Post Producer. The Conform action renders complex 
editing timelines into output media files, allowing you to automate the production of 
hundreds of customized outputs. The Compose action allows you to import timelines 
from editing systems such as Final Cut, Adobe, and Avid.

Transport—includes actions which allow you to copy, move, and delete files, and 
deploy them to external systems.

Common—utility actions for building complex logical and branching workflows: 
Compute, Construct, Decide, etc.

There many other categories and actions, as well as third-party actions for interaction 
with third party systems: Aurora, Signiant, Aspera, and others.

Take time to browse through the groups—open them up, and drag their actions onto 
the design space and review their Inspectors to gain a solid understanding of Workflow 
Designer’s comprehensive workflow building blocks.

Zooming In and Out on a Workflow
There are three ways to zoom in and out on a workflow:

• Drag the zoom slider bar at the bottom left of the workflow

• Repeatedly press Control+/- (the plus and minus keys)

• Use the scroll wheel on your mouse while pressing the control key.

To zoom a workflow, do the following:

1. If you closed Workflow Designer, open it again, and select the Simple Transcode 
workflow from your category in the Workflows panel (on the left).

2. With your Simple Transcode workflow selected and displayed in the Workflow 
Design workspace, click Edit at the bottom of the window.
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3. Use the zoom slider bar at the bottom left corner to zoom in and out to suit your 
viewing and editing needs.

Moving the Workflow Around in the Workspace
A workflow with many actions may be larger than you can view effectively in your 
workspace, when viewed at the zoom level you’re currently using. 

To move the workflow around in the workspace, click and hold anywhere on the 
workflow canvas (do not click on an action). When the cursor changes to a compass, 
continue to hold down the mouse button and drag the workflow in the appropriate 
direction.

Centering the Workflow in the Workspace
To center the workflow in your workspace, right-click in the workspace and select 
Recenter Workflow from the context menu. Alternatively, you can press Control-R on 
the keyboard.

Before you continue, take a few moments to practice zooming, moving, and centering 
the workflow—you’ll use these features frequently, especially as you create larger and 
more complex workflows. Becoming familiar with them now will make it easier to focus 
on the design process.

Using Auto Arrange
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow. Auto Arrange automatically moves actions into 
position for best layout as you place them on the canvas.

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow (especially a large one—30 actions or more), click the Auto Arrange button, 

Use the zoom slider bar to zoom 
your workflow in and out.

Enable or disable Auto Arrange to 
suit your construction style.
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located at the bottom of the Workflow Design workspace, to toggle it off. While Auto 
Arrange is off, the Auto Arrange button displays the phrase Auto Arrange SUSPENDED 
in yellow, and actions will not automatically organize themselves.

Click the button again to toggle auto arrangement back into effect.

Displaying and Updating Workflow Details
To display or hide a workflow’s details panel, do one of the following:

• Select File > Workflow Details panel.

• Click in the Workflow Design workspace’s title bar.

When you display the workflow’s details panel, Workflow Designer obscures the tabbed 
workspaces to display details about the workflow.

In the workflow details panel, you can use the following controls to manage the 
workflow information, including expiration, execution of the workflow in open mode, 
and automatic report generation. 

The information that displays below the Apply button includes creation and 
modification dates, and job statistics. The Expected Variables list indicates which 
variables are being utilized by actions in this workflow. If an action parameter in the 
workflow binds to a variable, it displays here.
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Conclusion
Congratulations! You’ve just learned how to use some of the features in the Workflow 
Design workspace. In the next tour, you will learn how to set up a workflow’s 
transcoding actions to use the settings that you want.
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Tour 4: Transcoding Files
Introduction
This tour adds to your workflow design and configuration skills. It’s an in-depth look at 
how effectively Vantage deals with the complexities of media transcoding. 

Duplicating a Workflow
It is often easier to duplicate a workflow and make minor modifications to it, rather 
than starting over with a new one. To duplicate a workflow, do the following:

1. If you quit Workflow Designer after the last tour, start it again. In the Workflows 
panel, open your Tutorial Workflows category. 

2. Select the Simple Transcode workflow.
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3. Select File > Duplicate Workflow (or right-click and select Duplicate...). Workflow 
Designer displays the Duplicate Workflow dialog.

4. Name the new workflow Complex Transcode. Click OK to create the new workflow 
and close the dialog.

Workflow Designer automatically selects the new workflow, places it in edit mode and 
displays it in the Workflow Design workspace.

Adding a Branch to a Workflow
Now, let’s add a second, pre-configured Flip action to your workflow. Recall that 
Workflow Designer has many pre-configured actions, making it easier to build 
workflows.

Let’s add this Flip action so that Vantage can encode two separate output files 
simultaneously, in a single workflow. By creating a branch with parallel Flip actions, 
each Flip is executed independently as soon as the Watch action completes (making 
the resources available). This design is more time-efficient than if one Flip action 
followed the other. Creating branches for parallel encoding is an important part of 
Vantage scalability and high-volume transcoding. To add a branch, do the following:

1. Open the transcode action group on the action toolbar.
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2. Click on the Flip action and select Mobile > 3GPP 300KBit H.264 with AAC preset 
from the menu to add it to the workflow, as shown here:

3. Connect the new Flip action to the Watch action—click and drag a connector line 
from the out connect pin (yellow dot) on the right side of the Watch action to the in 
connect pin (yellow dot on the left side) of the new Flip action—creating a new 
branch in the workflow.

4. Open the new Flip action’s Inspector and specify an output file nickname to identify 
the new file you’re encoding—Mobile 3GPP. 

5. Click Save to update the workflow in the database and close the Inspector.

Writing Output Files to Specific Locations
As this workflow is currently designed, newly-encoded media is saved in a Vantage 
store, because you have not explicitly configured the workflow to place the media in a 
specific folder. In order to use the new file after the workflow has completed—for 
example, on a broadcast server or QA server—you need to explicitly move it to a known 
location on your network.

Let’s add a Move action to each branch, so that the workflow places the new media in a 
specific folder. Move actions are part of the Transport group, and are file system actions. 
A Move action actually copies the file to the new location, then deletes the original. 
(Alternatively, if you want to keep the original file, you can use a Copy action, which 
places a copy of the file in the new location while keeping the file in the old location.)
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Move actions (and other file system actions) utilize a special feature called the Vantage 
folder address book, which enables you to store output locations, IP addresses, folder 
names and credentials in a single place. This makes it easier to manage destination 
locations for files.

To move the new files:

1. Open the Transport action group on the action toolbar. Drag a Move action onto 
the QuickTime branch, and another onto the 3GPP branch, connecting each to the 
Flip action, so that each Move executes after the Flip action.

2. Open the QuickTime branch’s Move action Inspector.

3. Select the QuickTime H264 AAC file by nickname, to identify the file to move.
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4. Click on the browse  button to the right of the Path field. Workflow Designer 
displays a browse window for selecting the destination folder for the media output. 

When specifying the path to the file, use a UNC path. A UNC path includes the 
server name. For example, here’s a UNC path, including the server LS3-Techpubs:

\\ls3-techpubs\C:\Users\chuckp\Videos\ 

Vantage Folder Address Book
As an alternative to browsing for a path every time, you can create a new Vantage 
Store in whatever location you like and add it to the Vantage Folder Address Book 
(shown below). The Address Book contains lists of frequently used Vantage Store 
addresses.
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• Vantage Folder Address Book simplifies directory referencing by allowing you to 
specify a fully-qualified output location by a simple name. 

• Vantage Folder Address Book also allows you to update a path or credentials cen-
trally, and automatically update all actions using that Vantage folder.

• For example, you might have a folder on a given server for HD MPEG2 content: 
\\Voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the address book for this path, and name it SunupHDWaitingAp-
proval. 

• If you need to change the path or any password associated with the address, you 
can simply change it in the address book and all actions will automatically update.

To add a destination to the Vantage Folder Address Book:

a. Select the Vantage Store/Folder (middle selection under Select the destination).
b. Click the button at the far right end of the Vantage Store/Folder selection to 

open the Vantage Folder Address Book.
c. Create a new Vantage folder—click the Add Folder button in the address book 

toolbar (the new folder button at far left):

d. Enter the folder name in the Name text box: VantageOut.
e. Click Modify to specify the directory that this Vantage folder address points to. 

Workflow Designer displays the Folder Location Editor.
f. Choose Windows File System and click Next. (Vantage folders can be defined for 

any supported file system.)
g. Click Browse to select a directory (for example, in Windows Explorer make a 

folder named VantageOut) where you want the output media file copied, and 
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click Select Folder. (Don’t use drive letters on a distributed Vantage array or 
distributed clients—they won’t work.)

h. Click Finish to close the Folder Location Editor dialog. (You may have to click OK 
on the local folder warning dialog.)

i. Click OK to add this new Vantage folder and close the Add New Folder dialog.
j. Click Select to specify this new folder as the destination for the Move action.

5. Click Save to save the destination configuration and close the Inspector.

6. Repeat the preceding steps for the 3GPP Move action—select the Mobile 3GPP 
nickname for the file you’re moving, and select the same destination—VantageOut.

When you’re done, your workflow should look like this:

7. Activate this workflow.

8. Automatically submit a media file to the hot folder for this workflow.



Tour 4: Transcoding Files
Introduction

50
Configuring a Flip Action
Now, let’s look at the original QuickTime Flip action that you added in Tour 2 in more 
detail, and learn how to change Flip action settings.

To change settings in this action, do the following:

1. Click Edit to deactivate the workflow and enter editing mode.

2. Display the Inspector of the QuickTime Flip action.

3. Click the Encoder menu to display the list of codecs you can use in the Flip action.

4. Click the Edit Filename Pattern button to control the output file name. By default, 
Flip actions name the files they create using the same root name as the original 
file’s name plus an appropriate extension, based on the encoder. For example, a 
QuickTime movie flipped from FlipDemo.mss is named FlipDemo.mov.

5. Leave the Decoder set for Auto to automatically decode the incoming format.

6. Click on the Video Stream component to display the Processor menu in the details 
panel below, where you select which video processor to use: Legacy 8-bit RGB, 
4:4:4, Multi-core 16-bit YCbCr 4:4:4:4, or Lightspeed Accelerated 16-bit YCbCr 
4:4:4:4, and others. 

7. At the right of the video stream, click the Video Codec menu to display the video 
codecs that are available. (Click the gear icon to cycle through the selection.)

8. To the right of the audio stream, click the Audio Codec menu to display the audio 
codecs that are available.

Encoder menu 
displays all 
encoders in the 
domain.

Video button & 
codec menu.

Audio button & 
codec menu.

Container button 
and menu.

Video and Audio 
stream buttons.

Video Processor 
selector.

Video/Audio 
Decoder button.
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9. At the far right of the Video and Audio Stream components, click the Container 
menu to display the containers that are available (notice that the QuickTime 
encoder only provides a QuickTime container).

Note: As you click on the video codec, audio codec, and container buttons to select 
them, configuration details change in the configuration panel at the bottom of the 
window. For example, the Video Codec configuration panel enables you to set frame 
width, height, and bitrate for the video in the QuickTime file.

When you select a stream (by clicking the audio or video stream buttons, far left), 
you can also add processing filters.

10. Select the Video Stream button in the toolbar, and then click on the Video Filter 
menu to display a list of video filters.
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11. Select the Chroma Settings filter. Workflow Designer adds it to the video stream 
and its controls display in the bottom panel. 

Notice that there are other filters for audio and other functions (mouse over them 
without clicking to see descriptions). These filters are available to provide control 
over how the transcode operates.

12. Click on the Video Codec at the far right to display the codec settings at the bottom 
of the window.

Video codec 
button
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13. Click the Frame Size/Frame Rate drop-down arrow to open and view the settings. 
Notice that you can change the frame width, height, and frame rate.

14. Finally, click the Encoder menu at the top to display the encoders that you can 
select. (Recall that you can configure a Flip from scratch, or you can select a 
template—which you did earlier when you added the 3GPP Flip action).

15. Click Cancel to close the Inspector without making any changes. 

Conclusion
In this tour, you’ve learned how to duplicate an existing workflow, how Vantage 
performs multiple simultaneous encodes, and how to create and use Vantage folder 
addresses. You’ve also learned how to configure Flip actions to perform encoding tasks.
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Tour 5: Using Nicknames 
to Identify Files
Introduction
This tour rounds out your knowledge of nicknames, and how you use them to easily 
track and process multiple files action by action in a workflow. It takes about 10 or 15 
minutes to complete.

Overview
A key feature of Vantage workflows is the notion of nicknames. A nickname in Vantage 
provides a convenient means of referencing a file, using only a word or logical phrase—
such as Original or QuickTimeH264AAC.

• In the context of a workflow, all files are referenced by a nickname which you assign 
as you either ingest (usually with a Watch or Associate action) or create a file (for 
example, with a Flip action). 

• Nicknames are used in every action that creates, accesses, or operates on a file.

• Nicknames provide a brief way to tell an action which logical file it should use to 
perform a task without fully listing the file path. 

• Vantage automatically keeps track of files and their associated nicknames as jobs run.

• Vantage provides a set of default nicknames which can be used in certain types of 
workflows or to enable certain Vantage features. 

• You can also assign your own nicknames which are meaningful in the context of your 
workflow. 

• Nicknames can be used over and over again in multiple workflows because they only 
have scope, or relevance, during the execution of the workflow, and have no context 
outside the workflow itself.

Note: For some complex media types—such as Omneon reference files or P2 camera 
files—media is actually a collection of files, all of which are necessary to make the 
media work. In this case, the nickname refers to the entire collection of media files; 
Vantage tracks all the video and audio files which comprise the media automatically.
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Deleting a File Using its Nickname
To reinforce the notion of using nicknames, let’s make one more change to the 
Complex Transcode workflow. The Delete action is a file system action which you use to 
delete a file that is no longer needed, using the nickname of the file. Let’s use it to 
delete the original file that was ingested by the Watch action, at the end of the 
workflow.

1. Select the Complex Transcode workflow—duplicate it as Complex Transcode Delete.

2. Open the transport actions group, and click and drag a Delete action into the new 
workflow, without connecting it to any action. Notice that no nicknames display on 
this action.

3. Connect the Delete action to the top Move action. 

Note: Notice that the nicknames now display on the Delete action. The list on the left 
are files available before execution; the list on the right are files available after 
execution. (After configuration, the files used in this action are highlighted.)

4. Open the Delete action Inspector (click the yellow i in the top left corner). 

The Delete action accepts one parameter: The nickname of the file that you want to 
delete. This list displays the nicknames of all files in the workflow that it knows of at 
the moment, based on its connection—Original (from Watch) and QuickTime H264 
AAC (from the connected Flip action).

5. Select Original (which identifies the input file) and click Save to close the Inspector.

Workflow Designer immediately highlights the other Flip action’s Original nick-
name in red, indicating an error. In this case, you’re attempting to delete a file that is 
being used by the Flip action in the other branch! By using nicknames, Workflow 
Designer can help you discover many workflow design issues automatically.

Nicknames of files 
in this workflow 
before execution of 
this action.

Nicknames of files 
in this workflow 
after execution of 
this action.
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6. Connect the Move action to the Delete action to merge the branches, (see below).

When the workflow branches are merged, the Flip actions are synchronized. As 
designed, the workflow waits for all upstream workflow branches to complete before 
executing the first action in the merged branch. 
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Thus, the Delete action will not execute until both Flip actions have completed. If it 
executed right after the top Flip action, it might delete the file (or attempt to delete it 
and fail) before the 2nd Flip had completed.

Also notice that the nicknames on the Delete action have been updated to include the 
file from the second Flip—Mobile 3GPP.

The Mobile 3GPP 
nickname is added 
to the list.
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Tour 6: Processing 
Attachments in Workflows
Introduction
This tour shows you how you can add attachment files—files associated with media 
files—to a workflow, and process them. 

• An attachment might be an XML file, a PDF, DOC, or any other file that needs to be 
stored with the media file as part of a job requirement.

• For example, a media file containing a news story might be accompanied by the 
text of the story with timecode markings in the text for use during video editing. 

• The Associate action, which is the subject of this tour, is used to watch hot folders 
for general attachment files, just like you use Watch actions to watch for media files.

• The Associate action discovers and pairs the attachment that contains the name of 
the media file with the media file so they can be processed together.

• Other actions, such as Workorder, Dublist, and Timed Text Flip also process attach-
ments for specific file types. 

• Workorder and Dublist are traffic management actions and are explained in the 
TrafficManager Guide.

• The Timed Text Flip action, which is used to add captions from an SCC or STL file to 
a media file, is covered in an application note on our web site.

The following simple example shows how to associate an XML file to a media file so the 
two can be processed together during and after transcoding.
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File Associate Workflow Description
Follow these steps to associate an XML file with a media file:

1. Launch Workflow Designer.

2. Create the workflow shown below, using Watch, Associate, Flip, and Copy actions. 
Name it File Associate.

1. Click the inspector button  on the Watch action and configure it to monitor a 
folder for incoming media files. If you need help, see Tour 1, Configuring the Watch 
Action. 

2. If you expect to receive media files and attachments in the same folder, you will 
need to set up the File Match Pattern in the Inspector for the types of media files 
you expect. This enables Vantage to recognize the difference between media files 
and attachments. See the figure below or hover the cursor over the Accept field for 
instructions. The File Match Pattern is set to accept only files with names matching 
the pattern *.[EXTENSION] where * is a wildcard representing any file name.

3. Click the inspector button  on the Associate action (or just double-click on the 
action itself ) to open the Inspector. The Inspector opens in read only mode.

On the first panel, note that Attachments is selected. (You can select other media 
files, but you cannot transcode them when ingested by an Associate action.)
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4. Click Next two more times to view the second and third Inspector panels. 

As in the Watch Inspector, these panels allow you to select the file system (select 
Windows) and specify the folder to watch for attachment files. Note that this can be 
the same folder being watched for media files or a different folder.

5. Click Next to view the fourth Inspector panel (below).

In this panel the incoming attachment file is assigned the nickname XML. Notice 
also that the File Match Pattern is set to accept only files with names matching the 
pattern [NAME]*.xml. 

Additionally, the Match file name is set to Original—the nickname of the matching 
media file ingested by the Watch action that started the job. These settings ensure 
that only XML attachment files with a root name that matches the media file name 
will be accepted. 

6. Click Next and Cancel to close the Associate Inspector.
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7. Click the Flip action inspector  to open it. 

On the open Inspector panel, set the Encoder for the type of media file, nickname 
the Input media file Original, and nickname the output media file Output. The spec-
ified output location is VantageOut--the store you created in previous tours. 

Click on each of the selections in the middle area to see the many transcoding and 
filtering options available, and also notice the additional parameters at the bottom 
of the panel that change with each selection in the middle area. 

Click Save to save your changes and close the Inspector.
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8. Click the Copy action Inspector to open it.

In the Select the nickname of the file to copy menu, select XML.

In the Select the nickname for the copy menu, enter XMLOutput.

In the Select the destination menu, select Vantage Store/Folder: VantageOut.

Click Save to save your changes and close the Inspector.

This action will copy the XMLOutput file into the same VantageOut store location as the 
transcoded media file.
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Running the Attachment Workflow
Now it’s time to test the workflow:

1. Locate or create a media file and a matching XML file. For testing, you can create a 
text file with the same name as the media file and change the file extension to xml. 
Ensure that the files are named identically except for the extension. 

2. Activate the workflow, and drop the media file and matching XML file into the 
Watch folder, or if they are already in the folder, use Submit Job in the Workflow 
Design window to start a job by selecting the media file.

3. Click on the Job Status tab and select the job to watch it execute (below). 
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4. Double click the job in the Job Status table to open the binder. 

The concept of a binder is used to identify and group together all the files belong-
ing to a particular job. Notice that the binder Media Files tab lists the Original and 
Output media files, both of which were used in this particular job. 

You can select the output file and play it in the binder’s preview player by clicking 
the green play button. 

Since a binder is a temporary collection of the files used in a job, when you delete 
the job, the binder is deleted also. (Binders are saved by using a Register action to 
register the binder into a Vantage catalog, as explained in a later tour.) 

5. Click the binder Attachments tab and notice that the XML and XMLOutput files are 
listed.

6. Right-click the XMLOutput file in the binder, and select Open Containing Folder to 
see the Output media file and its matching XML file in the VantageOut folder. 

The Flip action placed the Output media file in the VantageOut folder, and the Copy 
action copied the XMLOutput file there also.

7. Deactivate the workflow when you’re finished.
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Conclusion
In this tour, you learned about the following:

• Using a Watch action to discover a media file.

• Using an Associate action to discover an attachment file associated with the media 
files found by the Watch action.

• Using a Flip action to transcode the media file and place it in an output folder.

• Using a Copy action to copy the matching attachment file to the same output 
folder as the matching media file.

Using these principles, you can associate any file with a media file having a matching 
name, and keep the two of them together throughout the workflow, including using a 
Copy action to send the attachment to the same output folder or destination as the 
transcoded media file. Note that you can also use other Transport actions, such as Move 
and Deploy to place files in other desired locations.
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Tour 7a: Using Catalogs 
and Binders in Ingest 
Workflows

Introduction

In the last tour, we touched on catalogs and binders. You saw that when you view a 
completed workflow in the Job Status panel, you can double-click the job listed in the 
table to see the binder and the files that it includes. 

This tour introduces you to the concept of catalogs as an organizing principle for 
binders in Vantage. As you take the tour, you will create a catalog and a workflow to 
ingest media, create thumbnail and proxy files from the Original, and register all three 
in the catalog. These items—catalog, binder, original, thumbnail, and proxy are all 
needed in order to manually manage video projects using the Vantage Workflow 
Portal. Using the Portal, operators can make changes to the video and audio and then 
manually submit the media to another downstream workflow for transcoding and 
deployment.

The workflows and configuration files for both tours are available for download from 
the Telestream web site. Search the web site and download the General Workflows zip 
file. Extract the workflows from the file and import the workflows listed below:

• Tour 7a: Using Catalogs and Binders in Ingest Workflows covers creating catalogs 
and the ingest workflow to create an original, thumbnail, and proxy. Use the work-
flow named Ingest to Catalog.xml, or you can create the workflow following the 
steps provided.

• Tour 7b: The Workflow Portal and Trim Workflow describes a downstream workflow 
for transcoding and deploying files submitted to it from the Workflow Portal, which 
is the operator’s tool for video monitoring and management. Use the workflow 
named Trim from Catalog.xml and the Workflow Portal configuration file named 
Trimming Workflow Portal Configuration.xml or you can create the workflow and 
portal configuration using the steps provided.

To import workflows using the Workflow Designer, select File > Import Workflows... and 
select the workflow XML file. The workflow will appear in the left panel Workflows list.

To import a Workflow Portal configuration, open the Vantage Management Console, 
select Application Configurations > Workflow Portal, and use the blue Import down-
arrow button above the Configuration window to import the XML configuration file.
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Overview
A binder is a collection of file and metadata information, created for each job that 
Vantage executes. Each binder contains media and attachment file references and 
metadata labels that were ingested or created during the job. Binders allow files to be 
preserved (for access and further processing within Vantage) after the job completes.

Binders are not file folders—and are not part of the Windows file system—they are 
records in the Vantage database. Thus, binders do not contain media or attachment 
files; they only identify the paths to these files.

Catalogs help you organize binders. Catalogs are created in the Management Console. 
You can create binder expiration policies to help manage media, and catalogs can 
optionally be transient—that is, they can be automatically deleted when all of the 
binders have been removed and the catalog is empty. 

You use the Register action in a workflow to add binders to a catalog, and you use the 
Exist action to determine if a specific binder has already been added to a catalog. 
Binder names usually match the name of the file that started the job. Binders that are 
not explicitly registered are accessible to users only in Workflow Designer, in the Job 
Status workspaces, and if the job is deleted, the binder is deleted also.

Binders that have been registered are accessible by operators using Workflow Portal. 
Binders remain in a catalog until deleted manually or by expiration policies you set up.

Note: For management purposes, you can also view binders in the Vantage 
Management Console, and manually create them there—or delete them, but the 
Management Console is not designed to manage binders for production purposes.
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Ingesting Media
For the purpose of this tour, let’s examine a typical application of Vantage--to ingest 
media clips and register them into a catalog so that they can be processed 
downstream. Once media is prepared in this way, the catalog and binder can be passed 
on to operators who are responsible for examining the clips and preparing them for 
editing or broadcast. 

To ingest and register clips into Vantage catalogs, we’ll create the following 
components:

Trim Catalog—this catalog is intended to store binders created by a file ingest 
workflow. Catalogs are created using the Management Console.

Trimming Label—this label creates placeholders for information about the video that is 
filled in when the media is ingested and which can then be modified by operators 
using the Workflow Portal

Ingest to Catalog Workflow—ingests files and registers them in the Default Catalog.
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Creating a Catalog and Label
Catalogs are created using the Vantage Management Console. 

1. Launch the Vantage Management Console from the desktop icon.

2. Click Catalogs near the top of the list in the left panel.

3. Click the New Catalog icon to create a new catalog.

4. Type over the existing name to change it from New Catalog to Trim Catalog.

This completes catalog creation. 

Next, to make a Metadata Label, keep the Vantage Management Console open:

1. Select Workflow Design Items > Metadata Labels in the left column.

2. Select Create a new Metadata Label in the right Metadata Labels panel.

3. Name the label Trimming Label, and save it (blue floppy disk icon). Labels hold 
metadata that can be modified in the Workflow Portal and submitted to a workflow.
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4. In the Design section of the Trimming Label, use the New Parameter button to add 
these new parameters to the label and set the Value Type of each to Timecode: 

• Trim Group X IN

• Trim Group X OUT

• Trim Group X DURATION

You can also add a description to each parameter, if you like, such as “Enter Start/
End/Duration timecode here”.

This completes catalog and label creation. Later, in the workflow for this tour, you will 
register binders and metadata labels into the catalog using an ingest workflow.

The Ingest Workflow
In this typical ingest workflow, the Watch action monitors a hot folder for incoming 
clips. Set up the Watch action as described in previous tours to monitor a folder, 
discover the type of media file you want to detect, and nickname it Original.
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Thumbnail Flip
The center Flip action creates a JPEG thumbnail media file by capturing a single video 
frame from the Original video source:

• Encoder: Keyframes

• Input nickname: Original

• Output nickname: Vantage Thumbnail

• Select an Output Location
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Proxy Flip
The top Flip action creates a proxy for previewing and editing:

• Encoder: QuickTime Encoder

• Input nickname: Original

• Output nickname: Vantage Proxy

• Select an Output Location

This produces a 720 x 480, 29.97 H.264/AAC QuickTime movie encoded using the 
QuickTime encoder, with the required nickname of Vantage Proxy to allow playing 
in the preview player and the Workflow Portal. 

Refer to the Vantage User Guide Workflow Portal chapter for additional details 
about proxy files and formats.
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Populate Action Creates Label with Timecode
The Populate action creates a Trimming Label, with begin and end timecodes for 
multiple segments of video.

• Select Label from Variable

• Select Trimming Label

Be sure to check the segments that you will use for your trimming label after the 
Trimming Label is selected.
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Register Binders into Catalogs
The Register action registers the binders produced by this workflow into the Trim 
Catalog, so that the assets can be accessed and processed by an operator, using the 
Workflow Portal. The Register action ensures that the binder created by the job will 
exist after the job expires.
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Running the Catalog Workflow
Now we’re ready to run the workflow:

1. Locate or create a media file for testing. If you are using the sample workflows from 
the Telestream.net web site, use the Demo.mp4 file supplied with the workflows.

2. Activate the workflow, and drop the media file into the Watch folder, or if it is 
already in the folder, use Submit Job in the Workflow Design window to start a job.

3. Click on the Job Status tab and select the job to watch it execute (below). 

4. Double-click the job in the Job Status table to open the binder. In the binder Media 
Files panel, you should see an Original, a thumbnail, and a proxy. In the Metadata 
Labels panel, you should see the Trimming Label with parameters for multiple 
segments of video. This shows that the binder was created.

5. Open the Vantage Management Console, click on Catalogs, and click on the Trim 
Catalog. In the Media Files panel, you should see the same binder as in the previous 
step with the Original, Vantage Thumbnail, and Vantage Proxy, and you should see 
the same Trimming Label in the Metadata Labels panel. This shows that the binder 
was added to the catalog.

Conclusion
In this tour, you’ve created a catalog, a metadata label, and an ingest workflow. The 
workflow checks the video, makes a thumbnail and proxy, and registers the binder 
containing the original, thumbnail, and proxy into the catalog. These are the elements 
that need to be present in a typical ingest workflow that produces files to be monitored 
and managed using the Workflow Portal.

Next, this tour continues with the second half of the process—another workflow 
processes the video by trimming segments to the desired lengths. The operator sets 
the segment lengths by playing and adjusting the timecode in each segment in the 
Workflow Portal and then submits the marked video to a production workflow, which 
actually trims the segments to the desired lengths. See Tour 7b: The Workflow Portal and 
Trim Workflow.
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Tour 7b: The Workflow 
Portal and Trim Workflow
Introduction
In the second half of Tour 7, you will submit the catalog, binder, and label created in the 
Ingest to Catalog workflow to a Trim from Catalog production workflow. The resulting 
output will be a trimmed media file. You can import both workflows and even a media 
sample from the General Workflows samples provided on the Telestream web site. 

To submit to the production workflow, you will use the Vantage Workflow Portal 
application. The Portal is an operator’s application allowing manual monitoring and 
adjustment of ingested video and manual submission to downstream workflows.

The Production Workflow
In the Trim from Catalog example production workflow, the Watch action is replaced by 
a Receive action, because this workflow only executes when media is submitted to it by 
an operator using the Workflow Portal. A Receive action is required when submitting 
media to a workflow from another application, such as the Workflow Portal.
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Figure 1. Trim from Catalog Production Workflow

The Populate action converts the Trimming Label into variables for use in the workflow. 
Variables are covered in a later tour. 

Next, a Flip action executes the trim process on the Original media. The action uses the 
Media Trim movie filter and the begin and end timecode variables to trim the clip, and 
convert it into an MPEG-2 program stream. An operator enters timecode for the trim 
points using the Workflow Portal before submitting the media to the workflow.
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The Workflow Portal Configuration
Now that we understand the functionality of the production workflow, let’s briefly 
review the Workflow Portal configuration required to take the output of the first 
workflow and submit it to the second workflow. 

You can import this configuration (Trimming Workflow Portal Configuration.xml) from 
the General Workflows samples available by searching the Telestream web site, or you 
can create the workflow and portal configuration using the steps provided. To import 
the configuration using the Vantage Management Console, select Application 
Configurations > Workflow Portal > blue Import down-arrow button.

Workflow Portal Overview and Configuration
The Workflow Portal is a client program that can be customized to enable operators to 
manually modify media, metadata, and variables and submit them to workflows.

Customization is implemented in the Vantage Management Console, where Vantage 
administrators select user interface features and save them as a Workflow Portal 
configuration. Multiple configurations can be created for different operator tasks.

When operators launch the Workflow Portal, they select the configuration appropriate 
to the task at hand, and Workflow Portal dynamically implements the user interface 
specified in the configuration file, and provides access to the specified workflows, 
categories, and functions—specifications which are all part of the configuration.
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In this configuration, the mode is set to Browse Catalogs (Copy Binder). In this mode, 
when you submit a catalog and binder to the production workflow, the binder is 
duplicated when submitted—leaving the original binder intact in its original catalog. 

If you set the mode to Forward Binder instead of Copy Binder, the original binder from 
the original catalog is forwarded to the production workflow when a job is submitted, 
which may alter the files in the binder. 

If you don’t know which mode to use, Copy Binder is the safest choice, since it preserves 
your original catalog and binder. If you need to delete the binder later to prevent 
unneeded files from accumulating, you can do so manually or automatically by setting 
an expiration date for the binder.

Specifying the Catalog to Use
At the bottom of the configuration panel, note that (in the Browsable Catalogs tab) the 
catalog selected is the Trim Catalog. The catalog you specify here must be the same as 
the catalog where media is being registered by the Ingest to Catalog workflow.

Specifying the Label to Use
As shown below in the Labels tab, select the Trimming Label and use the center 
buttons to move it to the right panel to specify the label to use in the portal. The 
Trimming Label is already in the Visible to user column if you imported the sample 
workflow and configuration.

Specifying the Variables to Use
No variables are required because the workflows were designed to store the job values 
in a label. As an alternative, you could create variables and have the operator work 
directly with them if you wanted to. Variables are covered in a later tutorial.
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Specifying the Workflow to Use
As shown below in the Workflows tab, the operator can submit workflows to the Trim 
from Catalog production workflow, and it is required (checked).

This workflow must be activated in Workflow Designer in order to receive jobs after the 
operator has submitted them.

Specifying the Binder Details to Display
As shown below in the Binder Details View tab, the operator can view certain 
information and Workflow Portal controls.

All of the binder columns are displayed for the operator, plus the video Play button—so 
that the operator can scrub the video for in and out points and the keyframe timecode. 
The Submit button enables the operator to submit the media to the Trim from Catalog 
production workflow after updating all of the metadata.

Be sure to save the Workflow Portal configuration (blue floppy disk icon) when you are 
finished configuring it.
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When you are finished configuring and you have run the ingest workflow to create and 
register the binder, you are ready to use the Workflow Portal. 

Follow this procedure to access and operate the Workflow Portal:

1. Double-click the Workflow Portal desktop icon to start the application.

2. When you open the portal for the first time, it asks you to load the Configuration file 
you created previously, or select File > Change Reload Application Configuration. 

3. Click on the Trim Catalog in the upper left quadrant of the Workflow Portal, and 
click on the clip you intend to modify in the Trim Catalog clip list. 

The Workflow Portal should look like this. 

4. Click Submit at the bottom to open the Trimming Label parameters for editing.

5. Select and play the proxy video in the lower left quadrant to identify the trim points 
you want to use. 

6. Manually enter the timecode values for each segment in the Trimming Label, or use 
the Mark buttons. To manually enter timecodes, click on the start and end 
timecodes and type the timecode values.

7. Click Submit and select the Trim from Catalog workflow. This will send the binder 
and trim label to the workflow for processing to trim the actual media.
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Conclusion
In this tour, you learned that catalogs are used to register binders—media versions and 
related file and metadata, for processing in operator-intervention media processing 
systems. An ingest workflow containing a Register action affiliates the media and 
metadata with the binder. 

You also gained your first exposure to the Workflow Portal, which is an easy-to-use 
operator interface for intervening between workflows to perform manual checks and 
modifications to media and metadata.

Finally, you created a simple production workflow to create a trimmed output media 
file that is transcoded from one input format to a different output format by the Flip 
action. 
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Tour 8: Controlling 
Workflow Execution with 
Variables
This 30 minute tour introduces you to variables in workflows. Variables are used for 
passing important job information between actions, controlling execution flow, 
changing action priority, and controlling job routing.

Overview
In Vantage, a variable is a named unit of data (for example, an integer named Video 
Width) that only lasts as long as the job is executing. Variables can be used to pass data 
between actions. For example, an Analysis action might publish a variable named 
Video Width containing the width of the frame in a particular media file, and a Decide 
action might make a decision based upon the value of Video Width.

You can create and define variables in the Vantage Management Console, or you can 
define them directly in Workflow Designer, as you are configuring an action.

A variable can be supplied a default value, and the value of the variable may also 
change during the course of workflow execution. You can also use the current value of 
a variable without changing it—for example, determining if a numeric value (in the 
variable Video Width) is 720.

Each variable has three key characteristics that you define when you create it:

• Name (such as Number of Audio Channels)

• Type (such as Integer Number)

• Default value (such as 50)

Variable values can be changed in actions that are designed to use variables, such as 
the Analysis, Populate, Watch and Associate actions. 

Variables are passed from action to action through action connections. When an action 
creates (or sets) a variable, all downstream actions that use variables can access the 
variable’s current value. 

If an action creates a variable but doesn’t explicitly set its value, the variable’s default 
value (which is set in the Management Console) is used. For example, in the Complex 
Transcode workflow, you could set the Priority variable to 100 (higher priority) in one of 
the Flip actions; the other could use the default value of 0 (lower priority).
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Finally, variables are temporary; the information only lasts as long as the job is 
executing—and is known only in the context of the running job. 

Variables can be used in several ways:

• To dynamically control settings or change configurations in actions

• For routing tasks for execution on specialized platforms

• For decision-making to determine which branch of actions execute

• To determine the priority of a particular action.

Setting a variable in an action on one branch of a workflow does not affect the value of 
a variable with the same name on the other—because these are actually two different 
copies of the variable, in different branches.

Important Note: If workflow branches merge, variables with the same name collide in 
the first merged action. The value from the branch which completes last is updated 
last—and it is the value that is passed on. Because the branch which finishes last 
cannot be known when you create the workflow, Telestream recommends that merged 
branches have actions which explicitly reset colliding variables, before using them 
again downstream. If you need both variable values past the merge, you should start 
with two different variables; one on each branch.

Starting the Vantage Management Console
The Vantage Management Console is the program you use to configure and administer 
your Vantage domain—including Vantage services, licenses, and workflow design 
items, including variables. Vantage user accounts are also created in the console.

1. Double-click the Vantage Management Console shortcut to launch it.

2. Select a domain and log in using a Vantage user with administrative privileges 
(default: Administrator, no password), unless User Administration is disabled. 
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Creating Variables
1. Select Workflow Design Items > Variables to display the Variables panel.

The Variables panel displays a list of variables, which includes default variables plus 
those created by Vantage users in this domain. You can use the default variables in 
workflows as-is, and you can create your own.

2. Select the Curtained variable to display its details (which you can configure) at the 
bottom of the panel. (When focus is on the table, you can use keyboard keys to 
locate a given variable by name—for example, press R to go to the first variable in 
the list that starts with R.)

Rather than using a default variable, let’s create a new Date variable called File Mod-
ification Date.

3. To start, click the New Variable button in the toolbar (far left button).

4. Vantage displays the Create New Variable dialog. Select the type of variable you 
want to create—Date.

New Variable button in the toolbar



Tour 8: Controlling Workflow Execution with Variables94
5. In the details panel, enter the name File Modification Date, and leave the 
default value unchanged.

6. Click the Save button  to save your variable.

Note: There is nothing special about the name File Modification Date—you can create 
variables with any name that is not already in use. In this workflow, we will use this 
specific variable to store the modification date of the file, so we’ll name it descriptively.

Using System Variables
Vantage provides system variables as a domain-wide resource. These variables cannot 
be renamed, and they should not be deleted. 

The Priority variable is a system variable. The value of the Priority variable sets the 
priority of any actions that receive it to determine task balancing. Priority is a number, 
where larger numbers mean higher priority (for example, priority 10 is a higher priority 
than 1) over other actions competing for the same resource. You can set the Priority 
variable value in any action in the workflow—for example, Watch—to control priority 
of execution of all downstream actions in that workflow.

The Lightspeed, K20 and K80 system variables are assigned automatically to Lightspeed-
aware services, when they start up on any Telestream Lightspeed server. Their value is 
set to True. When a job runs, an action in that job can query these variables and use 
them for run-on rules or for reporting purposes.

The VantageMachineName system variable is automatically added to each Vantage 
service as it starts up on a server; it’s value is set to the name of the host upon which the 
service is running.

Setting Variable Values in a Workflow
The power of variables is that their value can change dynamically during execution of a 
workflow. There are several ways that a value changes:

• As the result of an action executing. For example, analysis (and many other) actions 
can publish their results as variables—such as determining the number of pixels 
that compose a letterbox. Similarly, Watch and Associate actions can publish infor-
mation about files that they detect, using variables.

• From external metadata. Specifically, the Populate action can set variables based 
upon metadata label values found in external files.

• From a Compute action, which can create variables from other variables. For exam-
ple, Compute can add two number variables to create a new variable.

• As a pre-step to an action executing; any action can set the value of any variable 
prior to execution.

• As a pre-step to a server executing an action; any service on any server can be con-
figured to set a variable before executing an action.



Tour 8: Controlling Workflow Execution with Variables 95
Let’s experiment with two of these. First, let’s modify one Flip action in the Complex 
Transcode workflow, so that Vantage processes it with a higher priority than the other.

1. Open Workflow Designer, and duplicate the Complex Transcode Delete workflow 
from Tour 5 as Complex Transcode Tour 8.

2. Right-click the QuickTime Flip action and select Add Variables from the context 
menu to display the Add Variables dialog.

3. Click the Add Variable(s) button in the toolbar to display the Select Variables dialog.
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4. Scroll through the list (or press the first letter of the variable—in this case P) and 
select the Priority variable—click OK to add it to this action.

Now, the Priority variable is attached to the workflow and its default value is 0. You 
can change the value of the variable at the bottom of the panel—higher numbers 
indicate higher priority, lower numbers indicate lower priority. 

5. Enter a large number (for example, 100) and click OK to make this variable setting 
permanent.

Next, let’s configure the Watch action to set the value of the File Modification Date 
variable that you created earlier, each time it picks up a file and submits a job.
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6. Open the Watch action Inspector and click Next three times to display the 
Configure Settings panel.

7. Under Generate Variables, check the File Modified Date checkbox.

8. Use the menu to the right to select File Modification Date, the variable that you 
created in the Management Console earlier in the tour. You could also add the new 
variable right here in the dialog.

9. Click Next, then click Finish.

Now, your Watch action will assign the file modified date value of each file that it 
submits for processing to the File Modification Date variable. You’ll see how we can use 
this variable in the next tour.

Conclusion
In this tour, you learned about managing and creating variables, as well as how to set 
variable values in a workflow. In the next two tours, you’ll learn about how to use 
variables for decision-making, and how to use them to pass information between 
actions in a workflow.
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Tour 9: Decision Making in 
Workflows
This hands-on tour takes about 20 minutes and introduces you to decision-making 
using variables to control the logical flow of media through a workflow.

Action States
As actions execute, they are passed the job’s action state from the previous action. If the 
action executes, they also set the action state before passing it on. Monitor actions 
represent an exception—as an origin action, they do not inherit an action state. Actions 
set one of three action states: Success, Ignore, or Fail. Some actions (Decide, Examine, 
Compare, and Identify, for example), allow you to configure a state. However, most 
actions’ state is set automatically—by the service that executes it.

The action state is automatically passed from one action to the next so that each action 
may determine whether or not to execute, based upon the incoming state. This pattern 
repeats throughout the execution of the entire workflow.

Action states also enable decision-making—causing actions (or entire branches of the 
workflow) to not execute.

To understand how to implement and utilize action states for decision-making and 
logic, it’s important to understand their precedence, whether an action receives states 
from one or multiple incoming actions (a merge of multiple branches):

• If at least one incoming action state is Fail, regardless of other incoming states, the 
action inherits Fail and must pass it on whether the action executes or not—Fail has 
precedence over all action states. Most actions will not execute if they inherit Fail. If 
one action fails, the entire job fails.

• If there is no Fail state, but at least one Success state, then the action inherits Suc-
cess—which has precedence over Ignore. Usually, actions execute when they 
inherit Success. After execution, the action may emit Success, Fail, or Ignore.

• If all incoming states are Ignore, the action inherits Ignore. Ignore has lowest prece-
dence of the three states. An action may or may not execute when inheriting an 
Ignore, based on its state execution setting. If an action receives an Ignore state and 
does not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state 
unless it is an action which can emit Ignore, and you have configured it to do so.
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Generally speaking, actions only execute if (1) none of their predecessors set the Fail 
state, and (2) at least one of the predecessors set the Success or Ignore state.

Similarly, if an action sets Ignore, the next action is unlikely to execute. Most actions, 
excluding Watch and Receive (since they are origin actions), can be configured to 
perform on certain states—to send an email for example, if they detect a failure.

Note: Actions can be configured to execute upon Fail or Ignore—for example, to 
send an email notification. To configure an action’s execution based on the incoming 
action state, right-click and select Perform On. You can also set an action to execute 
regardless of the state: Right-click and select Perform On > Any.

The Decide Action
The Decide action inspects selected incoming variables and sets the action state based 
upon the result of the value. Decide effectively acts as a gatekeeper to control 
branching by setting a Success, Ignore, or Fail state, which is passed on to the next 
actions, which can be set to conditionally execute, based on the incoming action state.

Because variable values are often specified at run-time, Decide enables you to perform 
an analysis and set its state at run-time as well—and thus, the workflows may behave 
differently for every job processed by the workflow. Decide is a powerful action 
allowing you to build data-driven processing into a workflow.

Note that if you want to have multiple branches in a workflow, and only execute 
specific branches for each job, then you’ll need multiple decides—one acting as a 
gatekeeper for each branch in the workflow.

Processing New Files
Let’s look at an example (start Workflow Designer if it isn’t already open).

1. Open the Complex Transcode Tour 8 workflow and duplicate it as Complex Transcode 
Tour 9. We’ll update this workflow to process only new files that are in the hot folder. 

Recall that in Tour 8 the Watch action was configured to publish a variable named 
File Modification Date. We’ll use this variable to process only those files created or 

modified after January 1st, 2010. 

2. Open the Watch action in the Complex Transcode Tour 9 workflow and set File 
Modified Date to publish the File Modification Date variable.
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3. In the actions toolbar, open the Common category and drag a Decide action onto 
the workflow so that the Decide action follows Watch, and all remaining actions 
follow the Decide action, as shown in the following figure.

4. Open the Decide action Inspector. 

5. The Decide action is designed to perform evaluations upon variables, and set a 
state if they meet all the conditions that you specify. 

6. In the top left, click Select Variables and add the File Modification Date variable.

7. Select the > (Greater) operator and set the test value to January 1, 2016, 12:00:00 
AM. 

8. Verify that the state selection is Success—meaning that if the date is later than 
January 1st, this action will emit a Success—and that the Otherwise state is Ignore. 

9. Click Finish to close the Inspector and update the workflow.

Now—because actions by default operate only when the incoming action state is 
Success, your workflow will process files created after January 1st, but will not process 
files created on or before this date. 

Filtering Old Files
But what if you wanted to simply delete old files?
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Let’s modify the workflow to delete old files. To do that, you’ll create a new branch off of 
Watch, with a Decide action and Delete action, as shown in this figure.

1. Add the Decide action, connected to the Watch on a separate branch. 

2. Now, open the Decide action Inspector, and configure similarly to the previous 
one—add the File Modification Date variable, select the reverse operator <= (Less 
Than or Equal), and set the date to January 1, 2016 12:00 AM. If this is true, Success is 
set; if false, Ignore is set. 

3. Click Finish to close the Inspector.

4. After the Decide action, add a Delete action and configure it to delete the Original 
file. It executes by default only on Success states.

This workflow now has two branches, each controlled by a Decide action—one will 
process only new files, the other will process only old files. Because of the way we 
configured the Decide actions, each file submitted will only be processed in one branch 
in this workflow.

Conclusion
In this tour, you’ve learned how to assign values to variables, to test those values, set 
action states, and use the Decide action to make run-time decisions—all features 
designed to enable you to add control to your workflows, based on information you’ve 
gleaned from your input file.
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Tour 10: Analyzing and 
Modifying Media Files
This hands-on tour takes about 15 minutes and introduces you to the concept of 
dynamic parameters in Vantage, and how they can be used to pass information 
between actions in a workflow.

Note: To execute workflows you create in this tour, you’ll need a license—certain 
features (the Examine action, for example) will not execute without one. For a trial 
license, contact sales@telestream.net.

Thus far, when we have configured our actions in a workflow, parameters have been set 
at a fixed value. For example, the frame size of a transcode output is 320x240. 
Obviously, by using fixed values the action performs the task the same way each 
time—creating an output file that is 320x240—every time this action executes.

How would workflow processing improve, if we could change these settings and 
parameters job-by-job, on the basis of the media being processed?

Vantage supports this capability to dynamically change the value of parameters and 
settings by binding parameters to variables. Recall that variables are metadata that is 
only known at run-time, and this metadata may be different for every single file. In 
Vantage workflows, you can configure almost any parameter, in almost any action, to 
use a variable (and its current value) as its input.

Automatically Detecting and Cropping Curtains
Let's build a real-world example. In this example, we know that some of our content has 
black on the left and right—curtains—that we want to crop. However, the amount of 
black is likely to be slightly different for every file being processed in Vantage. Instead 
of creating many workflows to deal with each situation—and manually measuring the 
black before processing, we'll build a workflow to crop the curtains automatically, as 
appropriate for each incoming media file, by combining an Examine action with a 
transcode with filters implemented.

1. Open the Complex Transcode workflow from Tour 4 again, and duplicate it as 
Complex Transcode Tour 10. 

mailto:sales@telestream.net
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2. Open the Analysis group and add an Examine action—connect it between the 
Watch action and the QuickTime H.264/AAC Flip action. (You can place the action 
directly on the connector line and it will automatically connect to both, replacing 
the line.)

3. Open the Examine action Inspector.

4. Click the Analyzer menu and select Curtain Detection. Workflow Designer displays 
the configuration setting for this analysis tool.

5. Open Generate Variables and configure this action to publish two variables (by 
checking them): Suggested Crop Left (select the Curtained Left Pixels variable) and 
Suggested Crop Right (select Curtained Right Pixels). 

Note: Vantage provides many predefined variables for use in your actions. While this 
is convenient, you’re certainly free to create your own variables and you may often 
need to in order to support your specific applications.

6. Under Input Media File Nickname, select Original as the file to analyze. 

7. Click Save to update the action and close the Inspector.

8. Open the Inspector of the Flip action immediately after Examine.

9. Click on the Video Stream button, then click the triangle in the Video Filter button 
(2nd from the right) to display the video filters you can use. Add a Resizing video 
filter to the transcode. 

10. Select the Resizing filter to display its parameters at the bottom of the window.

11. Expand Cropping and Padding, and select Manual from the drop-down menu.

12. Click the green variable buttons beside Crop Left and Crop Right, and bind those 
values to the Curtained Left Pixels and Curtained Right Pixels variables, respectively.

13. Click Save when you’re done. 

14. Choose a media file that contains curtained material, submit a job for processing, 
and view the results.

You should see a dynamic transcode that automatically adjusts Resizing settings based 
upon incoming curtain data from the curtain detection Examine action. The resulting 
media file has full-screen video with the curtains removed from the sides. Because 
variables are used instead of fixed curtain definitions, transcoding automatically adapts 
to the curtain width of each media file, cropping the output to full screen regardless of 
variations in curtain width!

Take a moment to explore the rest of the transcode settings in this Inspector, and 
notice the bind buttons on many parameters. You’ll find the bind button in other 
actions as well, allowing you to define many values with variables that detect actual 
values in the media files rather than using fixed values.
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Conclusion
In this tour, you learned how to create dynamic parameters that use variables as their 
inputs. This feature enables you to create powerful, dynamic workflows that adaptively 
change what they do based on the metrics of the media being processed.
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Tour 11: Understanding 
and Using Open Workflows
The Vantage Open Workflows licensed option offers a way to add processing efficiency 
and speed to your Vantage workflows. Using Open Workflows, Vantage jobs can run 
many times faster on the same hardware because of concurrent processing. 

How does it work? With Open Workflows, open-enabled actions in a workflow can run 
in parallel, unlike the serial operation of traditional Vantage closed workflows. 

Looking at the figures below, you see a closed workflow running serially in the upper 
view. The Flip action is running while the second Copy action waits for the Flip action to 
finish. In the lower view, the open Copy and Flip actions run concurrently. The 
differences in processing and other details about closed versus open workflows are 
explained in detail in the next topic.

Closed Workflow

• Existing Vantage behavior     • Actions execute sequentially

• Throughput is constrained    • Run time is cumulative

Open Workflow

• Optional open capability   • Actions may run concurrently

• Throughput is dynamic      • Run time is greatly reduced
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Closed and Open Workflow Processing
Prior to Vantage 7.0, action processing was closed, which means that each action 
cannot begin processing until the previous action has completed. A closed workflow 
enables you to systematically control the processing flow, especially when you want to 
use Service Limits and to have explicit control over Vantage nodes. 

The workflow shown below illustrates closed workflow operation: 

• The blue actions have completed.

• The Flip action has begun working.

• The subsequent Copy action is waiting for the Flip Action to complete. 

The inherent latency of this job is expressed as follows:

the time of the first Copy + the time of the Flip + the time of the second copy

If the first Copy (labeled Localize) pulls from a remote file system with poor throughput 
and this action takes 10 minutes to complete, the Flip action cannot begin processing 
for 10 minutes. If the Flip action transcodes the file in 3 minutes and the final Copy 
takes 5 minutes, the total job time is 10 + 3 + 5 or 18 minutes. 

Latency refers to the serial nature of how one action must wait until the preceding 
action completes. This process incrementally increases the overall job time at each step. 
The cumulative nature of this sequential processing is illustrated below:
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The Open Workflow Difference
In contrast to closed workflows, Open Workflows permit most actions to operate 
concurrently. That is, the current action can be performed while the previous and 
subsequent actions are also being executed. This removes the inherent latency 
associated with the discrete steps of a traditional closed workflow.

Refer to the following workflow in which Open Workflows is enabled. You can see that 
the Copy, Flip and the final Copy are all working at the same time as shown by their 
green Job Status. Once the media blocks have been written to disk in the first Copy, the 
Flip action is able to read these media blocks and begin the transcoding process. When 
the Flip action finishes processing and writes the resultant transcoded media blocks to 
disk, the final Copy action moves them to the appropriate destination.

Using the numbers from the closed workflow example, the first Copy action will still 
take 10 minutes. However, since the Flip action and the final Copy action can begin 
processing the incoming file almost immediately, the overall job will be completed in a 
time that is much closer to 10 minutes. The figure below illustrates the concurrent 
nature of this execution:
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Open Workflow Indicators
Open Workflows include certain visual characteristics so you can recognize open 
actions. As shown below, connectors are hollow, and the nicknames are italicized if an 
action is operating in open mode. Actions in closed mode look the same as they always 
have, with filled connectors and regular type.

Open Actions
Many actions can execute in Open mode—but not all. Additionally, in some instances, 
the inbound processing to the action may be open but the outbound is closed, and 
vice versa. The following table summarizes the actions supported by Open Workflows.

Hollow connectors 
for open mode

Oblique font for 
open mode

Service Actions
Open 
Inbound

Open 
Outbound Notes

Monitor Watch N/A Yes Windows, FTP, HTTP and Aspera; other file 
systems as the need arises. On Windows 
only, the file being submitted can be an 
open, growing file (one that is being 
written). On other file systems, the file 
must be complete and closed before it 
can be submitted.

Transport Copy Yes Yes Input and output may be TIFO, Transport 
Stream or Program Stream files; only valid 
when using the Windows File System.

Transcode Flip Yes Yes Input only for supported file formats 
(below)

Note: In order to localize a file from a file system other than Windows in open mode, the file must 
already be complete. For example, in the following workflow: Watch (FTP) > Copy (local Vantage 
store) > Flip, the Copy and Flip actions will run in open mode when the source file on the FTP server 
is a complete, closed TIFO file, since the Flip action only supports TIFO open inbound.

Multiscreen Multiscreen Flip Yes No Input only for supported file formats 
(below).

IPTV IPTV Flip Yes Yes Input only for supported file formats 
(below).
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Open File Formats
Only file formats that are able to be read while being written (aka “growing files”) can 
be supported by Open Workflows. This is fundamentally controlled by both the file 
wrapper and the codec selected for transcoding operations.

Note: In order for a transcoding action to ingest media an input in open manner, the 
decoder must be configured for a format that supports Open Workflows.

The following file formats are supported for both reading and writing in all open 
transcoding actions listed in the preceding table:

• All actions that are open capable support open TIFO for inbound, outbound, or 
both depending on the action

• Open Transport Stream is only supported for IPTV Flip and Flip actions outbound

• Open Program Stream is only supported for Flip actions outbound

• Flip actions only support PCM audio for inbound

Choosing an appropriate file wrapper greatly enhances the speed of execution for an 
Open Workflow. The Telestream Intermediary Format (TIFO) offers a good choice for file 
wrapping as it supports Open Workflows and all codecs. When you are capturing live 
content from a Telestream Pipeline HD Dual or the Lightspeed LiveCapture server, the 
media can be a TIFO wrapped file that can immediately be consumed by a Vantage 
Open Workflow for extremely fast live content deployment.

If you need additional speed, adding a Telestream Lightspeed Server will further 
increase processing speed and reduce the time to produce media assets.

Open Workflows are ideal for scenarios where media residing on external systems (S3 
buckets, FTP locations, and Aspera servers) is to be localized, processed, and delivered 
to external storage locations, Files processed on S3, FTP or Aspera systems are limited 
to complete, closed files in TIFO format.

Edit Tempo, Conform No Yes Input only for supported file formats 
(below).

Live Capture No Yes Outbound only.

Metadata All Actions (Populate 
and Transform)

Yes No Instantaneous, no media dependency; 
XML files are closed.

Common Compute, Construct, 
Decide

Yes Yes Instantaneous, no media dependency, 
actions will not run until input variables 
are all available.
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Open Workflows are also ideally suited for Vantage workflows in which one action is 
creating a mezzanine file for the purpose of a second action creating a specific 
rendition. For example, Post Producer might create a high resolution mezzanine file 
followed by employing the Cable IPTV Flip to produce a vendor specific Transport 
Stream.

Licensing Requirements
Licenses are required for Open Workflows. These licenses may be enabled for an entire 
domain, or for individual nodes within a Vantage array. If Open Workflow licenses are 
acquired for specific nodes, then Workflow jobs that need to take advantage of Open 
Workflow processing can be submitted to these specific nodes.

Creating Open Workflows
You create an Open Workflow using the Workflow Designer in the same way as a 
standard workflow. However, Open Workflows must be enabled in three places:

• Enable domain level in Vantage Management Console Settings & Options > General

• Enable workflow level in Workflow Designer, workflow drop-down

• Enable action in context menu (right click) Workflow Mode

These are the steps to create your first Open Workflow:

1. Open the Vantage Management Console, select Settings & Options, select the 
General tab, and check Enable Open Workflows.

2. Open the Workflow Designer and create a new workflow, such as this one.

Enable Open Workflows
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3. Select the workflow drop-down menu, and check Options: Open mode.

4. Right-click each action in your workflow, select Workflow Mode, and check Open.

That’s all there is to it. You can submit jobs and use the workflow as you normally 
would. Notice that the Job Status shows some of the open actions operating 
simultaneously.

Conclusion
In this tour, you learned about Open Workflows and how they differ from the closed 
workflows Vantage has previously employed. Now you can begin analyzing your 
existing workflows to see what kind of efficiency gains might result if you convert some 
of them to Open Workflows.

Enable Open Mode

Workflow Drop-down Menu
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